
Chapter 3

Working with 
Architecture Workspace
 Learning Objectives  
After completing this chapter, you will be able to:
• Add columns and grids
• Add walls
• Add windows and doors
• Add stairs, railings, and stair tower
• Add roofs and slabs	
• Create layouts
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INTRODUCTION
In AutoCAD MEP, before designing an MEP project, its architectural model is required. An 
architectural model consists of the following elements: Walls, Doors, Windows, Floors, Stairs, 
Roofs, Beams, and Columns. It also consists of standard views, sheets, and units. You can add 
these elements in the project using the Architecture workspace. In this chapter, you will learn 
to use various tools and options to add and create architectural elements using the Architecture 
workspace.

ARCHITECTURE WORKSPACE
To work with the architectural plans, you need to invoke the Architecture workspace. To do so, 
choose the Architecture option from the flyout displayed on choosing the Workspace Switching 
button available in the Application Status Bar; the tools required for performing architectural 
operations will be displayed in the Ribbon, refer to Figure 3-1.

Figure 3-1  The Ribbon displayed on invoking the Architecture workspace

The procedure of creating various components of an architectural structure such as wall, door, 
window, grid, and so on are discussed next. 
 

CREATING WALLS					        
Walls are the building blocks of a structure. The tools to create a wall are

Figure 3-2  The Wall 
drop-down 

available in the Wall drop-down of the Build panel in the Home tab of 
the Ribbon, refer to Figure 3-2. There are three tools for creating walls: 
Wall, Curtain Wall, and Curtain Wall Unit. These tools are discussed 
next.

Wall
This tool is used to create the straight and curved walls. To create 
a wall, choose the Wall tool from the Wall drop-down available 

in the Build panel of the Home tab in the Ribbon; you will be prompted to specify the start 
point of the wall. Also, the PROPERTIES palette will be displayed. The prompt sequence for 
creating a wall by choosing the Wall tool is given next.

Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: Specify the start point 
of the wall segment.
End point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: Specify the end point of 
the current wall segment and starting point of the next wall segment.
End point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc/Undo]: Specify the end 
point of the current wall segment and starting point of the next wall segment.
End point or 
[STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc/Undo/Close/ORtho close]: Specify the 
end point of the current wall segment and starting point of the next wall segment.
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End point or 
[STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc/Undo/Close/ORtho 
close]: 

Note
You can also invoke the tools given in the Ribbon by entering the corresponding command at 
the command prompt.

There are various options available in the command prompt to change the properties of the wall. 
Alternatively, you can select these options from the shortcut menu displayed on right-clicking 
in the drawing area. These options are discussed next.

STyle
This option is used to change the style of the wall to be created. You can create a wall style by using 
the Style Manager which will be discussed later in this chapter. You can also choose a wall style 
from the STYLES BROWSER palette. By default, the Standard style is chosen as the wall style.

Group
This option is used to specify the cleanup group for the wall. These cleanup groups are created 
by using Style Manager which is discussed later. When two walls of the same group intersect each 
other, they get automatically cleaned up at the intersection point, refer to Figure 3-3. Figure 3-4 
shows the intersecting walls of two different groups.  

Figure 3-3 The intersecting walls of same 
cleanup group

Figure 3-4  The intersecting walls of two 
different groups

WIdth
This option is used to specify the width of a wall. The width specified using this option will be 
applicable for all the walls that are created after specifying this value. The prompt sequence for 
changing the width of a wall is given next.

Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: WI
Width <240>: Specify the desired width. 
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: 
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Height
This option is used to specify the height of the wall. The height specified using this option will 
be used for all the walls to be created afterwards. To view the height of wall, you need to switch 
to the isometric view. The prompt sequence for changing the height of wall is given next.

Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: H
Height <3000>: Specify the desired height. 
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: 

OFfset
This option is used to set the distance of centerline of the wall from the wall edge. By default 
the value is set to zero. Figure 3-5 shows a wall being created using the OFfset option. 

Figure 3-5   The wall being created with centerline at its default position

Flip
This option is used to flip the direction of wall creation to either side of the cursor. You can also 
press the CTRL key once to change the direction of the wall.

Note
The Flip Command works only if the Justification option selected from the PROPERTIES 
palette is either Left or Right.

Justify
This option is used to switch the cursor position to the right, center, and left points of the wall. 
When you choose this option, four options will be available at the command prompt to justify 
the wall. You can also switch between the justification option by pressing the SHIFT key. The 
command prompt for justifying the wall after choosing the Wall tool is given next.

Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: J
Justification [Left/Center/Right/Baseline] <Baseline>: Enter the justification option.
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: 

The justification options available at the prompt are discussed next.

Left 
The Left option is used to justify the wall on the left of the cursor.

Center 
The Center option is used to justify the wall on the center of the cursor.
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Right 
The Right option is used to justify the wall on the right of the cursor.

Baseline 
The Baseline option is used to justify the wall on the center of the baseline.

Match
This option is used to match the properties of the wall to be created with an existing wall. On 
choosing this option, you will be prompted to select a wall with which the properties will be 
matched. At the next prompt, enter the property names to be matched. The options available 
at this prompt are Style, Group, Width, Height, Justify, and All. After specifying the options, 
you will be prompted to specify the start point of the wall. Specify the start point and the end 
point of the wall to create a wall having properties similar to the one selected for matching. 

Arc
This option is used to create a wall in the shape of an arc. The command prompt for creating 
an arc shaped wall is given next.

Command: WALLADD 
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: A 
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Line]: Specify the Start point 
of the wall segment.
Mid point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Line]: Specify the Mid point 
of the wall segment.
End point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Line]: Specify the End point 
of the wall segment.
Mid point or 
[STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Line/Undo/Close]: Specify the Mid point of 
the next wall segment or enter Close to close the wall segment.
End point or 
[STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Line/Undo/Close]: Specify the Mid point of 
the next wall segment or enter Close to close the wall segment.

Line
This option is used to create straight walls. This option will be available at the command prompt 
only when the Arc option is active. The command prompt for creating an arc shaped wall is 
already discussed.

Undo
This option is used to invert the changes made by the previous command. Using the Undo 
option, you can invert the changes made by the wall command in the current session.

Close
This option is used to create a wall that makes a closed boundary by joining the other walls. 
When you choose this option, a wall connecting the first and last walls is created.
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ORtho close
This option is used to join two wall segments to make a closed boundary of walls. The command 
prompt for creating a wall using this option is given next. 

Command: WALLADD
Start point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: Specify the Start point 
of the wall segment.
End point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc]: Specify the End point 
of the wall segment.
End point or [STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc/Undo]: Specify the End 
point of the wall segment.
End point or 
[STyle/Group/WIdth/Height/OFfset/Flip/Justify/Match/Arc/Undo/Close/ORtho 
close]: ORtho 
Point on wall in direction of close: Click on the direction in which you want the two perpendicular 
connecting walls to meet; the joining walls will be created, refer to Figure 3-6 and Figure 3-7.

Figure 3-6  The corner point to be selected for 
the perpendicular walls

Figure 3-7  The wall created after selecting the 
corner point using the ORtho close option

You can also change the properties of a wall by using the PROPERTIES palette. Select the wall 
and then enter the PR command at the command prompt; the PROPERTIES palette will be 
displayed, as shown in Figure 3-8. Various rollouts available in this palette are discussed next.

BASIC Rollout
The options available in this rollout are used for basic settings. There are three options available 
in this rollout and they are discussed next.

General  
The options in this rollout are used for specifying general settings such as the layer, 
description, style of the wall, and the segment type. When you click on the Style Preview 
area of this rollout, the STYLES BROWSER palette will be opened. Now you can change 
the wall style type directly by double-clicking on the required style in gallery of the STYLES 
BROWSER palette. The selected style will be added to the Style drop-down list and its 
preview will be displayed in the Style Preview area of the PROPERTIES palette. You can also 
change the cleanup properties for the intersecting walls by using the options in this rollout.
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Figure 3-8  The PROPERTIES  palette displayed 
on selecting a wall

Note
Like changing the style of the walls, you can change the style of Curtain Wall, Curtain Wall 
Unit, and other objects by using the PROPERTIES palette. These objects will be discussed 
later in this chapter.

Dimensions
The options in this rollout are used to specify the height, width, and length of the wall. You 
can also justify the wall by using the Justify option available in the rollout.

Location   				 
The options available in this rollout are used to change the rotation angle and elevation of 
the wall. You can also change the insertion point and the orientation of wall by using the 
Location dialog box which is displayed on choosing the Additional information option 
available in this rollout.

ADVANCED Rollout
The options available in this rollout are used for changing the advanced settings such as cleanups, 
styles, overrides and worksheets. These options are discussed next.   

Cleanups  
The options in this rollout are used for changing the cleanup radius for intersecting walls. 
You can also apply overrides for the start and end cleanup radii by using the options available 
in this rollout.
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Style Overrides
The options in this rollout are used to override the starting and ending endcap styles. You 
can also set the priority of a wall with respect to an intersecting wall by using the Priority 
overrides option available in this rollout.

Worksheets 
The options in this rollout are used to modify the cross-section of the wall. You can also 
specify the start point and the end point of the modifiers by using the options in this rollout.

  

Curtain Wall
This tool is used to create a curtain wall. A curtain wall is a non-structural wall which 
is used to avoid the effect of weather on the building. This wall does not support any 

load in the building. The curtain walls created by using the Curtain Wall tool can be straight 
or curved.

The command prompt for creating a curtain wall is given next.

Command: CURTAINWALLADD
Start point or [STyle/Height/Match/Arc]: Specify the start point of the wall segment.
End point or [STyle/Height/Match/Arc]: Specify the end point of the current wall segment and start 
point of the next wall segment.
End point or [STyle/Height/Match/Arc/Undo]: Specify the end point of the current wall segment and 
start point of the next wall segment.
End point or [STyle/Height/Match/Arc/Undo/Close/ORtho close]: Specify the end point of the current 
wall segment and start point of the next wall segment or enter Close to create a closing wall.

The options available in the command prompt have already been discussed. You can also use 
the PROPERTIES palette to change properties of the created wall. The options available in 
the PROPERTIES palette for a curtain wall are discussed next.

BASIC Rollout
The options available in this rollout are used for basic settings. Most of the options available in 
this rollout are same as discussed earlier. Rest of the options are discussed next.

Dimensions  
The options in this rollout are used to change the base height, length, start miter, and end 
miter. 

ADVANCED Rollout
The options available in this rollout are used to change the advanced settings. The options 
available in this rollout are already discussed.

Curtain Wall Unit
This tool is used to create a unit of curtain walls. On choosing this tool, you will be 
prompted to specify the start point of the wall. Specify the start point of the wall; 

you will be prompted to specify the end point of the wall. Specify the end point of the wall; you 
will be prompted to specify the height of the wall. On specifying the height, the Curtain Wall 
Unit Styles dialog box will be displayed, as shown in Figure 3-9. 
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Figure 3-9  The Curtain Wall Unit Styles dialog box

Select a curtain wall unit style from the dialog box and choose the OK button; the wall unit with 
the defined specifications will be created in the drawing area. Using the PROPERTIES palette, 
you can change the properties of a curtain wall unit. The options available for a curtain wall 
unit are the same as discussed earlier.

CREATING DOORS					      

Figure 3-10 The Door 
drop-down list

Doors are movable structures used to close the entrance of a room 
or building. The tools to create a door are available in the Door 
drop-down of the Build panel in the Home tab of the Ribbon, refer 
to Figure 3-10. There are three tools available in the Door drop-down: 
Door, Opening, and Door/Window Assembly. These tools are 
discussed next.

Door
This tool is used to create doors of a specified profile. To create a door, choose the Door 
tool from the Door drop-down; the PROPERTIES palette will be displayed, refer to 

Figure 3-11 and you will be prompted to select a wall or a grid assembly. You can press ENTER 
to create a door as an individual entity or you can attach the door with a wall. To attach a door 
to the wall, select an existing wall; you will be prompted to select an insertion point. Select the 
desired point on the wall; the door will be created with the parameters specified in the 
PROPERTIES palette. The options available in the Dimensions rollout of the palette are 
discussed next.

Standard sizes
This drop-down list displays various standard sizes created by using the Style Manager. You 
can choose any of the standard sizes for the door or you can specify a custom size by using the 
options available in the PROPERTIES palette.

Tip. To add an arched door, choose the Style Manager tool from the Style & Display 
panel in the Manage tab; the Style Manager will be displayed. In the Style Manager, 
create a new door style with arch shape. The Style Manager will be discussed in the 
later chapters.



3-10			                	       AutoCAD MEP for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 3-11 The PROPERTIES palette displayed on 
choosing the Door tool

Width
This option is used to specify the width of the door, refer to Figure 3-12. This option is used 
to customize a standard door. By default, the width specified by Door style is displayed in this 
field. You can change the value in this field as per your requirement. 

Figure 3-12  Specifications of an arched door
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Height
This option is used to specify the height of the door, refer to Figure 3-12. This option is used 
to customize a standard door. By default, the height specified in the Door style is displayed in 
this field. You can change the value in this field as per your requirement. 

Measure to
The options available in this drop-down list are used to specify whether the width and height of 
the door is measured from the inner edge of the frame or the outer edge of the frame.  

Swing angle
This option is used to specify the maximum angle at which the door can be opened.  

You can change the parameters related to the location of a door by using the options available 
in the Location rollout. Some of the options available in the Location rollout of the palette are 
discussed next.

Opening Percent
Using this edit box, you can specify the opening percentage of the door. This option will be 
available when you select the arch type or halfround type door.

Vertical alignment
The options in this drop-down list will be available only if the selected door is anchored. Using 
these options, you can specify whether the height of the door will be measured from the threshold 
of the door or from the head of the door.  

Head Height/Threshold Height
The Head Height or Threshold Height option gets activated depending on the selection made 
in the Vertical alignment drop-down list. Using these options, you can specify the height of 
door from the head/threshold.

Rest of the options in the PROPERTIES palette have already been discussed.

Opening
This tool is used to create an opening of a specified profile in the wall. To create an 
opening, choose the Opening tool from the Door drop-down in the Build panel of 

the Home tab; you will be prompted to select a wall or press ENTER. Select the wall on which 
you want to create an opening; you will be prompted to specify the insertion point. Click to 
specify the insertion point on the wall; the opening will be created. On selecting an opening, 
the PROPERTIES palette will be displayed, as shown in Figure 3-13. Some of the options 
available in the PROPERTIES palette are used to change the properties of an opening. These 
options are discussed next. 

Shape
This drop-down list is available in the General rollout of the Basic rollout. The options in this 
drop-down list are used to change the shape of the opening. There are 13 types of predefined 
shapes available in this drop-down list for creating an opening. You can customize the shape of 
an opening by selecting the Custom option from the drop-down list. On selecting the Custom 
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option, the Profile drop-down list will be displayed below the Shape drop-down list. You can 
create the selected custom profiles of opening using this drop-down list. 

Figure 3-13  The PROPERTIES palette displayed 
on selecting an opening

Width
This option from the Dimensions rollout is used to specify the width of opening.

Height
This option from the Dimensions rollout is used to specify the height of opening.

Vertical alignment
This drop-down list is available in the Location rollout. The options in this drop-down list 
will be available only if the selected opening is anchored. Using these options, you can specify 
whether the height of opening will be measured from the sill level of the opening or the head 
of the opening. 

Door/Window Assembly
This tool is used to create a door or window assembly. The assembly contains 
required number of doors, windows, or both. To create a door/window assembly, 

choose the Door/Window Assembly tool from the Door drop-down available in the Build panel 
of the Home tab; you will be prompted to select a wall, a grid assembly, or press ENTER. Select 
a wall; you will be prompted to specify the insertion point for door/window assembly. Click at 
the desired point on the wall; an anchored door/window assembly will be created. The options 
available in the PROPERTIES palette for a door/window assembly are same as discussed earlier. 
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CREATING WINDOW
Windows are openings in a wall or door to facilitate the passage to light. If not closed, they also 
allow air and sound to pass through the wall or door. In AutoCAD MEP, windows are created by 
using the tools available in the Window drop-down. This drop-down list is available in the Build 
panel of the Home tab. The tools available in this drop-down list are discussed next.

Window
This tool is used to create a standard window. To create a window, choose the Window 
tool from the Window drop-down available in the Build panel of the Home tab; you 

will be prompted to select a wall, a grid assembly, or press ENTER. Select a wall; you will be 
prompted to specify an insertion point. Click on the wall to specify the point; the window will 
be created at the specified point. Click on the wall to create more windows or press ENTER to 
exit the command. You can set the opening percentage of window by using the Opening percent 
field available in the PROPERTIES palette. The other options available in the PROPERTIES 
palette have already been discussed. 

Corner Window
This tool is used to create a window at the point where two walls meet. This window 
can only be created on a cornered wall. To create a corner window, choose the 

Corner Window tool from the Window drop-down available in the Build panel; you will be 
prompted to select a wall. Select a wall which is connected to the other wall at the corner; you 
will be prompted to specify the insertion point. Click on the wall to place the window and press 
ENTER to exit the command. 

There are three conditions for creating a corner window. They are:
1.	 The walls meeting to create a corner must be in “L” shape.
2.	 Wall joints must be created by linear walls only.
3.	 Wall will join with similar components of intersecting walls.

Various options available in the Dimensions rollout of the PROPERTIES palette are discussed 
next.

Standard sizes
The options in this drop-down list are used to change the standard size of the corner window. 
The standard sizes are generated by using the Style Manager. The pattern of size displayed in 
this drop-down list is given next.

	 (Width 1 x Width 2) x Height

Here Width 1 and Width 2 represent width of the window in two different directions, and Height 
is the height of window from bottom edge to top edge. 

Width
This field shows the total width of the window. This is the sum of the Width 1 and Width 2 
values. You cannot change the value of this field.
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Width 1
This edit box is used to change the value of the width in the first direction. When you click on 
this edit box, a button will be displayed on the right of the edit box. On choosing this button, 
you can specify the value of width by selecting two points in the drawing. The value changed in 
this edit box is also reflected in the Width field and the Standard sizes drop-down list.

Width 2
This edit box is used to change the value of width in the second direction. When you click on 
this edit box, a button will be displayed on the right of the edit box. On choosing this button, 
you can specify the value of width by selecting two points in the drawing. The value changed in 
this edit box is also reflected in the Width field and the Standard sizes drop-down list.

Height
This edit box is used to change the value of height of the window. 

Measure to
The options available in this drop-down list are used to specify whether the value of width and 
height will be measured from inside of the frame or outside of the frame.

Opening measure
The options available in this drop-down list are used to specify the width measurement pattern. 
There are three options available in this drop-down list: Inside of opening, Center of opening,  
and Outside of opening. 

Inside of opening 
When you choose this option, the width of the first side of corner window is measured from 
the inner edge of the other side of the corner window.

Center of opening 
When you choose this option, the width of first side of corner window is measured from the 
center of the edge of other side of the corner window.

Outside of opening 
When you choose this option, the width of the first side of corner window is measured from 
the outer edge of the other side of the corner window.

Opening percent
Using this edit box, you can specify the opening percentage of the window.

CREATING ROOFS AND SLABS
The tools to create roofs and slabs are available in the Roof Slab drop-down, refer to Figure 3-14. 
The tools in this drop-down are Roof Slab, Roof, and Slab. These tools are discussed next. 

Roof Slab
This tool is used to create a segment of roof. This segment does not have a direct 
connection with other entities. To create a roof slab, choose the Roof Slab tool from 
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the Roof Slab drop-down available in the Build panel of the Home tab; 

Figure 3-14  The Roof 
Slab drop-down

you will be prompted to specify the start point of the roof slab. The 
command sequence for creating a roof slab is given next.

Specify start point or [STyle/MOde/Height/Thickness/SLope/OVerhang/
Justify/MAtch]: Specify the Start point of the roof slab.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/
Justify/MAtch]: Specify the next point of the wall segment.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/
Justify/MAtch/Undo/Ortho close]: Specify the next point of the wall segment.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo/
Ortho close/Close]: Specify the next point of the wall segment or enter Close to close the boundary.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo/
Ortho close/Close]: Specify the next point of the wall segment or enter Close to close the boundary.

After selecting a roof slab, the PROPERTIES palette will be displayed, as shown in Figure 3-15. 
Various options available in the Dimensions rollout of this palette are discussed next. 

Figure 3-15  The PROPERTIES palette displayed on selecting a roof slab

Thickness
This edit box is used to specify the thickness of the roof slab. When you click on this edit box, a 
button is displayed on its right. On choosing this button, you can specify the value of thickness 
by selecting two points.
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Vertical offset
This edit box is used to specify the offset value of the slab from the original position in vertical 
direction. You can also specify the offset value by selecting two points.

Horizontal offset
This edit box is used to specify the offset value of slab from the original position in the horizontal 
direction. You can also specify the offset value by selecting two points.

Edges
This button is available below the Horizontal offset edit box. When you choose this button, 
the Roof Slab Edges dialog box will be displayed, as shown in Figure 3-16. Also, a preview of 
the changes made in the edges are displayed in the Preview area on the right in the dialog 
box. You can change the parameters such as overhang value, edge style, and edge cut type by 
using the table displayed on the left in the dialog box. Various columns available in this table 
are discussed next.

Figure 3-16   The Roof Slab Edges dialog box

Edge
All edges of the selected roof slab are displayed in this column by their sequence numbers. 
When you select any sequence number, its respective edge is highlighted in the Preview area.

A-Overhang
Using the fields available in this column, you can change the overhang value. Overhang is 
the area of slab which is out of the support boundary.  
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Edge Style
By default, the values in this column are set to NONE. You can choose any predefined style 
for slab edges. You can define an Edge Style by using the Roof Slab Edge Style node in the 
Style Manager. You can also import the edge styles by using the STYLES BROWSER palette.

B-Edge Cut
In this column, edge cut methods are displayed. There are two options for edge cut: Square 
and Plumb. The Square option is used to cut the edge perpendicular to the roof slab whereas  
the Plumb option is used to cut the edge perpendicular to the ground.

C-Angle
In this column, you can specify an angle for the edge. If you enter a positive value, the bottom 
edge will extend. If a negative value is entered, then the top edge will extend.

Rise
This edit box is used to specify the value of rise for a roof slab. Rise is the slope difference between 
the start and end edges of the slope of roof slab along vertical direction. You can also specify 
the value of rise by selecting two points. To do so, choose the button displayed at the right of 
this edit box; you will be prompted to select points. Select the points to specify the rise value.

Run
This field is used to display the value of run for a roof slab. Run is the horizontal span of the 
slope. The value in this field is generally fixed.

Slope
This edit box is used to specify the value of slope for a roof slab. The value of slope is specified 
in degrees. Any change in the value specified in the Rise or Run edit box is reflected in the 
Slope edit box. 

Hold fascia elevation 
The options in this drop-down list are used to manage the fascia of roof. There are three 
options available in this drop-down list: No, By adjusting overhang, and By adjusting baseline 
height. 

No 
When you choose this option, the alignment of fascia is ignored.

By adjusting overhang 
When you choose this option, the fascia is aligned with the roof slab by adjusting the overhang.

By adjusting baseline height 
When you choose this option, the fascia is aligned with the roof slab by adjusting the 
baseline height.

Pivot Point X 
This edit box is used to specify the position of pivot point of roof slab in X direction. You can 
calculate the value of position in X direction by using the QuickCalc button available on the 
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right of the edit box. You can also use the Pick Point tool to specify the pivot point location 
which is discussed in the next section. 

Pivot Point Y
This edit box is used to specify the position of pivot point of roof slab in Y direction. Alternatively, 
you can specify the position of point by using the Pick Point tool available on the right of the 
edit box. You can also use the QuickCalc button as discussed earlier.

Pivot Point Z 
This edit box is used to specify the position of pivot point of roof slab in Z direction. Alternatively, 
you can specify the position of point by using the Pick Point tool available on the right of the 
edit box. You can also use the QuickCalc button as discussed earlier.

Roof
This tool is used to create a multi-peaked roof. To create a multi-peaked roof, invoke 
the Roof tool from the Roof Slab drop-down available in the Build panel of the Home 

tab; you will be prompted to specify the roof points. Specify the roof points; the roof will be 
created with the specified roof points. The PROPERTIES palette displayed on selecting a roof 
is shown in Figure 3-17.    

Figure 3-17  The PROPERTIES palette displayed on selecting a roof

The options available in the General, Dimensions, and Location rollouts are same as discussed 
earlier. The options available in the Lower Slope rollout are discussed next.

Plate height 
This edit box is used to specify the height of the base point of roof from the ground. You can  
also specify the plate height by using two points. In this case, you need to choose the Pick Point 
button available on the right of the edit box.
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Rise
This edit box is used to specify the value of rise for a roof. Rise is the difference in start and 
end edges of the slope of roof along vertical direction. You can also specify the value of rise by 
selecting two points. To do so, choose the button displayed at the right of this edit box; you will 
be prompted to select points. Select any two points on the screen to specify the rise value.

Run
This field is used to display the value of run for a roof. Run is the horizontal span of the slope. 
The value in this field is generally fixed.

Slope
This edit box is used to specify the value of slope for a roof. The value of slope is specified in 
degrees. Any change in the value specified in the Rise edit box or Run edit box is reflected in 
the Slope edit box. 

You can also specify the plate height, rise, and slope value for the upper slope of the roof. To 
specify the values for the upper slope, you need to select the Double slope option from the 
Shape drop-down list in the Dimensions rollout. On doing so, the Upper Slope rollout will 
be displayed. The options in this rollout are similar to the options discussed for Lower Slope 
rollout. 

Slab
This tool is used to create flat roofs or floors. The roofs or floors created by using this tool are in 
the form of a segment. This segment does not have a direct connection with other entities. To 
create a slab, choose the Slab tool from the Roof Slab drop-down available in the Build panel 
of the Home tab; you will be prompted to specify the start point of the slab. The command 
prompt for creating a slab is given next.

Specify start point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch]: Specify 
the Start point of the roof slab.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch]: Specify 
the next point of the wall segment.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo/
Ortho close]: Specify the next point of the wall segment.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo/
Ortho close/Close]: Specify the next point of the wall segment.
Specify next point or [STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo/
Ortho close/Close]: C
Specify start point or 
[STyle/MOde/Height/Thickness/SLope/OVerhang/Justify/MAtch/Undo]:

After selecting a slab, the PROPERTIES palette is displayed, as shown in Figure 3-18. The 
options in the palette have already been discussed.
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Figure 3-18  The PROPERTIES palette displayed on selecting a slab

CREATING STAIRS AND RAILINGS
Stairs are the structures that connect one floor to another, thus enabling easy movement. Railings 
are the structures which act as support or barrier on the stairs. The options to create stairs and 
railings are available in the Stair drop-down. These options are discussed next.

Stair
This tool is used to create rectangular stairs. There are various shapes of stairs such as straight, 
multi-landing, spiral, and U-shaped. While going on a curved path, the stairs can have curved 
landing. In such cases, the edges of stairs can also be curved. To create a stair, choose the Stair 
tool from the Stair drop-down available in the Build panel of the Home tab; you will be prompted 
to specify the start point of the stairs. Specify a point as the start point of the stairs; you will be 
prompted to specify the end point of the stairs. Specify a point as the end point to complete the 
stairs. While specifying the end point, you can specify the landing at desired position but this 
position must be within the specified limits. The limit of a stair is counted by the value specified 
in the Riser count edit box. The PROPERTIES palette displayed after choosing the Stair tool 
is shown in Figure 3-19. Some important options available in the General rollout of the palette 
on choosing this tool are discussed next. 

Shape			 
The options available in this drop-down list are used to specify the shape of the stairs. There are 
four options available in this drop-down list; U-shaped, Multi-landing, Spiral, and Straight. 
These options are discussed next. 
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U-shaped 
Using this option, you can create U-shaped stairs, refer to 

Figure 3-19  The PROPERTIES palette 
displayed on choosing the Stair tool

Figure 3-20. In this type of stairs, the two rows of 
stairs run parallel and meet at the end points by a 
half-landing. 

Multi-landing 
Using this option, you can create stairs having 
multiple landings, refer to Figure 3-20. You can 
provide quarter landing or half landing. This 
landing can be flat or can have a turn. 

Spiral 
Using this option, you can create stairs in the shape 
of spiral, refer to Figure 3-20. In this type of stairs, 
the steps of stair revolve about a common center 
point from bottom to top. Spiral stairs can be in 
clockwise direction or counter-clockwise direction.

Straight 
Using this option, you can create straight stairs, 
refer to Figure 3-20. In this type of stairs, the steps 
are created on a straight path that is inclined to 
the horizontal plane.

Turn type
This drop-down list is displayed only when U-shaped or Multi-landing is selected from the 
Shape drop-down list. The options available in this drop-down list are used to define the type 
of landing or turning for the U-shaped or multi-landing stairs. There are four options available 
in this drop-down list which are discussed next.

1/2 landing 
Using this option, you can create the U-shaped or multi-landing stairs having a flat landing 
of user-defined length, refer to Figure 3-21. 

1/2 turn 
Using this option, you can create the U-shaped or multi-landing stairs having steps at the 
turn, refer to Figure 3-21. Note that there must be at least three segments in the stairs and 
direction of turn of all the segments must be the same.
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Figure 3-20  Various type of stairs available in AutoCAD MEP

1/4 landing 
This option is available only when Multi-landing is selected from the Shape drop-down 
list. When you select this option, the width of landing created at turn will be equal to the 
width of the stair, refer to Figure 3-21. Generally, these type of stairs have two or more steps 
joined to the square landing. 

1/4 turn 
This option is available only when Multi-landing is selected from the Shape drop-down 
list. When you select this option, the resulting stairs will have steps at the turn, refer to 
Figure 3-21. These stairs can turn in both directions.
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Figure 3-21  Stairs with different turning types selected

Winder Style
This drop-down list is available only when 1/2 turn or 1/4 turn is selected from the Turn type 
drop-down list. There is a single type of winder style available in AutoCAD MEP: Balanced. The 
Balanced winder style is used to distribute steps of stairs evenly throughout the run. 

Horizontal Orientation
This drop-down list is displayed only when U-shaped or Spiral is selected from the Shape 
drop-down list. The options available in this drop-down list are used to define the direction of turn 
of stairs. There are two options available in this drop-down list: Clockwise and Counterclockwise. 
Using these options, you can select the clockwise or counterclockwise direction of turn of the stairs.

Vertical Orientation
The options in this drop-down list are used to specify the vertical direction of the stairs. There 
are two options available in this drop-down list: Up and Down. The Up option is selected when 
you need to create stairs from lower floor to higher floor. The Down option is selected when 
you need to create stairs from higher floor to lower floor.

The options in the General rollout are also used to control the shape of stairs. Some important 
terms used for defining the size of stairs are displayed in Figure 3-22. The options available in 
the Dimensions rollout of the palette are used to control the size of stairs. These options are 
discussed next.

Width
This edit box is used to specify the width of a step. You can also specify the width of a step by 
using two points. To do so, click on the button displayed on the right of the edit box; you will be 
prompted to select start point for width calculation. Select a start point; you will be prompted to 
select an end point for width calculation. Select a point; the width value for the specified points 
will be reflected in the edit box.  
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Figure 3-22  Some important terms for defining the size of stairs

Height
This edit box is used to specify total height of the stairs. You can also specify the total height of 
stairs by using two points. The method of using the points is already discussed.

Justify
The options in this drop-down list are used to change the justification of stairs. There are 
three options available in this drop-down list: Left, Right, and Center. These options change 
to Inside, Outside, and Center if the option selected from the Shape drop-down list is either  
U-shaped or Spiral. 

Terminate with
The options in this drop-down list are used to change the justification of stairs. There are three 
options available in this drop-down list: Riser, Tread, and Landing. When you select the Riser 
option, the stairs end with a riser. When you select the Tread option, the stairs end with a tread. 
If the Landing option is selected, the stairs end with a landing. Figure 3-23 shows the output 
of various options selected from the Terminate with drop-down list.

    
Flight length
This drop-down list will be available when the Multi-landing option is selected from the Shape 
drop-down list. The options in this drop-down list are used to control the length of one segment 
of a staircase. There are two options available in this drop-down list: Distance and Tread length. 
Using the Distance option, you can specify the flight length by specifying total distance value. 
Using the Tread length option, you can specify the flight length by specifying the length of 
one tread. The total flight length is calculated on the basis of number of treads in the staircase. 
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Figure 3-23  The output of various options selected from the Terminate with drop-down list

Calculation rules
When you click on the Tread button displayed in this field, the Calculation Rules dialog box 
will be displayed, as shown in Figure 3-24. By default, the D-Tread edit box is activated. On 
changing the value in this edit box, the value in the other edit boxes in this dialog box will change 
accordingly. To change values in other edit boxes manually, you need to lock the D-Tread edit 
box. To do so, choose the lock button; the Calculation Rules dialog box will be displayed, as 
shown in Figure 3-25. Now, you can change the value of any of the edit box in the dialog box 
by choosing the button adjacent to the respective edit box. In this dialog box, you can manually 
define the value in two edit boxes simultaneously. But if you choose the C-Riser edit box for 
defining the value of riser manually, then the other three edit boxes will be locked.  

Figure 3-24  The Calculation Rules dialog box
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Figure 3-25  The Calculation Rules dialog box displayed after locking the edit boxes

The value of the edit boxes that are set to change manually can also be changed directly using 
the PROPERTIES palette. Note that in the PROPERTIES palette only those edit boxes will 
be active that are set to change manually in the Calculation Rules dialog box. 

Some of the options in the PROPERTIES palette are displayed only when Spiral is selected 
from the Shape drop-down list of the palette. These options are discussed next. 

Specify on screen
This option will be available only when Spiral is selected from the Shape drop-down list. The 
options in this drop-down list are used to specify whether the second point specifies the radius 
along the starting direction or not. There are two options available in this drop-down list: Yes 
and No. When you select Yes from this drop-down list, then you can specify the radius of stairs 
on the screen while creating the stairs.

Radius
This edit box is available only when you select the No option from the Specify on screen 
drop-down list. Using this edit box, you can specify the value of radius for the spiral stairs. 

Arc constraint
The options in this drop-down list are used to constrain the arc of the spiral stairs. There are 
three options available in this drop-down list: Free, Total degrees, and Degrees per tread. When 
the Free option is selected from this drop-down list, the stair run is unconstrained. When Total 
degrees is selected from this drop-down list, you can specify the total angle of arc around which 
the stairs are created. When you select the Degrees per tread option, you can specify the angle 
of each tread with respect to the adjacent stairs.  

Arc angle
This edit box is active only when the Total degrees or the Degrees per tread option is selected 
from the Arc constraint drop-down list. Using this edit box, you can specify the value of arc 
angle. The value specified in this edit box is linked to the option selected in the Arc constraint 
drop-down list. If you have selected the Total degrees option from the Arc constraint drop-down 
list, then the value specified in the Arc angle edit box is applicable for total degree of the spiral 
stairs. If the Degrees per tread is selected from the Arc constraint drop-down list, the angle 
value specified in the Arc angle edit box is applicable for each tread. 
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Other options in the Dimensions rollout have already been discussed. Some of the important 
options available in the Advanced rollout of the PROPERTIES palette are discussed next. 

Top offset 
This edit box is available in the Floor Settings rollout. This edit box is used to specify the value 
for thickness of the floor at the top of the stairs.
 
Bottom offset 
This edit box is also available in the Floor Settings rollout and is used to specify the value of 
thickness of the floor at the bottom of the stairs.

Minimum limit type 
This drop-down list is available in the Flight Height rollout. Using the options available in this 
drop-down list, you can change the minimum limit for the height of flight. There are three 
options available in this drop-down list: NONE, Risers, and Height. By default, the NONE 
option is selected in this drop-down list. As a result, no limit is set for height or risers of the 
stairs. You can specify the minimum limit of risers by selecting the Risers option from the 
drop-down list. You can also specify the minimum height of stairs by using the Height option 
from this drop-down list.

Minimum Risers 
This edit box is available in the Flight Height rollout only when the Risers option is selected 
from the Minimum limit type drop-down list. You can specify the minimum value for height 
of the riser by using this edit box.

Minimum Height 
This edit box is available in the Flight Height rollout only when the Height option is selected 
in the Minimum limit type drop-down list. You can specify the minimum value for height of 
the stairs by using this edit box.

Maximum limit type 
Using the options available in this drop-down list, you can change the maximum limit for the 
height of flight. There are three options available in this drop-down list: NONE, Risers, and 
Height. By default, the NONE option is selected in this drop-down list. As a result, no limit is 
set for height or risers of the stairs. You can specify the maximum limit of risers by selecting 
the Risers option from the drop-down list. You can also specify the maximum height of stairs 
by using the Height option from this drop-down list.

Maximum Risers 
This edit box is available in the Flight Height rollout only when the Risers option is selected 
from the Maximum limit type drop-down list. You can specify the maximum value for height 
of the riser by using this edit box.

Maximum Height 
This edit box is available in the Flight Height rollout only when the Height option is selected 
from the Maximum limit type drop-down list. You can specify the maximum value for height 
for the stairs by using this edit box.
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Headroom height 
This edit box is available in the Interference rollout. This edit box is used to specify the height 
of ceiling around the stairs opening from the tread. This height is required so that people do 
not collide with the roof while going through the stairs.

Left clearance 
This edit box will be available in the Interference rollout only when Straight or Multi-landing 
is selected from the Shape drop-down list. This edit box is used to specify the clearance value 
for stairs from the left edge of the opening in the roof.

Right clearance 
This edit box will be available in the Interference rollout only when Straight or Multi-landing 
is selected from the Shape drop-down list. This edit box is used to specify the clearance value 
for stairs from the right edge of the opening in the roof.

Inside clearance 
This edit box will be available in the Interference rollout only when Spiral or U-shaped is 
selected in the Shape drop-down list. This edit box is used to specify the clearance value for 
stairs from the inner edge of the opening in the roof.

Outside clearance 
This edit box will be available in the Interference rollout only when Spiral or U-shaped is 
selected in the Shape drop-down list. This edit box is used to specify the clearance value for 
stairs from the outer edge of the opening in the roof.

Component 
This option is available in the Worksheet rollout. It is used to edit the parameters for stairs. 
When you choose this option, the Stair Components dialog box will be displayed, as shown in 
Figure 3-26. The options available in this dialog box are discussed next.

Figure 3-26  The Stair Components dialog box
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Note
You can edit the parameters in this dialog box only when you have selected the Allow Each Stair 
to Vary check box from the Components tab of the required Stair Styles in the Style Manager. 
The Style Manager is displayed on choosing the Style Manager tool from the Style & Display 
panel of the Manage tab in the Ribbon.

Tread 
This check box is available in the Flight Dimensions area. This check box is used to enable 
change in the value of tread thickness.

Riser 
This check box is available in the Flight Dimensions area. This check box is used to enable 
change in the value of riser thickness.

A - Tread Thickness 
This edit box is activated only when the Tread check box is selected. Using this edit box, you 
can specify the value for tread thickness. An annotated preview of all the related parameters 
will be displayed in the left of dialog box. 

B - Riser Thickness 
This edit box is actived only when the Riser check box is selected. Using this edit box, you 
can specify the value for riser thickness. An annotated preview of all the related parameters 
will be displayed on the left in the dialog box.

C - Nosing Length 
This edit box is used to specify the length for extended portion of tread over the riser.

Sloping Riser 
Select this check box if you want to create riser with a slope.

D - Landing Thickness 
This edit box is available in the Landing Dimensions area. This edit box is used to specify 
the value for thickness of the landing.

E - Additional Width 
This edit box is available in the Landing Dimensions area. This edit box is used to specify 
the value for additional width of landing.

Reset to Style Values 
This button is used to reset the value of all the parameters to their original values. This 
button is available at the bottom of the dialog box. 

Landing extensions 
This tool is available in the Worksheet rollout. This tool is used to edit the parameters for stairs 
related to landing extensions. When you choose this tool, the Landing Extensions dialog box will 
be displayed, as shown in Figure 3-27. The options available in this dialog box are discussed next.
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Figure 3-27  The Landing Extensions dialog box

Note
You can edit the parameters in this dialog box only when you have selected the Allow Each Stair 
to Vary check box from the Landing Extensions tab of Stair Styles in the Style Manager. The 
Style Manager is displayed on choosing the Style Manager tool from the Style & Display panel 
in the Manage tab of the Ribbon. 

A - Distance to First Tread DOWN 
This edit box is used to specify the value of extension of the tread attached to the lower 
riser. By specifying this value, you can extend the landing up to desired distance towards 
lower riser.

Add Tread Depth 
Select this check box if you want to add tread depth to the value specified in the Distance 
to First Tread DOWN edit box.  

B - Distance to First Tread UP 
This edit box is used to specify the value for extension of the tread attached to the higher 
riser. By specifying this value, you can extend the landing up to desired distance towards 
higher riser.  

Add Tread Depth 
Select this check box if you want to add tread depth to the value specified in the Distance 
to First Tread UP edit box.

Extend Landings to Prevent Risers and Treads Sitting under Landings 
This check box is available below the preview area. Select this check box if you want to create 
landing at the level of the adjacent riser and tread. If you clear this check box, you will get 
flush or rectangular landings.
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Extend Landings to Merge Flight Stringers with Landing Stringers 
This check box is available in the Stringer Resolution area of the dialog box. Select this 
check box to extend the landings so that the landing stringers merge with the flight stringer.

Railing
This tool is available in the Stair drop-down of the Build panel in the Home tab. This 
tool is used to create a stand-alone railing as well as a railing attached to stairs or some 

objects. To create a stand-alone railing, choose the Railing tool from the Stair drop-down; you 
will be prompted to specify the start point of the railing. Select a point as the start point; you 
will be prompted to specify the end point of the railing. Select a point as the end point; you will 
be prompted to specify the end point again. You can specify an end point for the next segment 
or you can press ENTER to exit the command. Figure 3-28 shows an annotated railing created 
with guardrail, handrail, and bottomrail. Figure 3-29 shows the PROPERTIES palette displayed 
on selecting a railing.

Figure 3-28  An annotated railing Figure 3-29  The PROPERTIES palette displayed 
on selecting a stand-alone railing

Some of the important options available in the Dimension rollout of the PROPERTIES palette 
are discussed next.

Rail locations 
When you select this option, the Rail Locations dialog box will be displayed, as shown in 
Figure 3-30. Various options available in this dialog box are discussed next.
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Figure 3-30  The Rail Locations dialog box

Note
The options in this dialog box can be edited only when the Allow Each Railing to Vary check 
box is selected from the Rail Locations tab of the Railing Styles option in the Style Manager. 

Guardrail 
When you select this check box, the edit boxes available next to the check box get activated. 
Using these edit boxes, you can specify horizontal height, sloping height, and offset value of 
guardrail from the post. You can also specify the side of offset by using the options available 
in the Side for Offset drop-down list.  

Handrail 
When you select this check box, the edit boxes available next to the check box get activated. 
Using these edit boxes, you can specify horizontal height, sloping height, and offset value of 
handrail from the post. You can also specify the side of offset by using the options available 
in the Side for Offset drop-down list.

Bottomrail 
When you select this check box, the edit boxes available next to the check box get activated. 
Using these edit boxes, you can specify horizontal height, sloping height, and offset value 
for bottomrail from the post. You can also specify the side of offset by using the options 
available in the Side for Offset drop-down list. When you select the Bottomrail check box, 
then the Number of Rails and Spacing of Rails edit boxes get enabled. Using the Number 
of Rails edit box, you can specify the number of rails to be created from the bottom. Using 
the Spacing of Rails edit box, you can specify the value of spacing between two successive 
bottom rails.

Post locations 
When you choose this tool, the Post Locations dialog box will be displayed, as shown in 
Figure 3-31. The options available in this dialog box are discussed next.
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Figure 3-31  The Post Locations dialog box

Note
The options in this dialog box can be edited only when the Allow Each Railing to Vary check 
box is selected from the Post Locations tab of Railing Styles in the Style Manager.

Fixed Posts 
This check box is used to enable the edit boxes that are used to modify the value of extension 
of the post. There are two edit boxes to change the value of extension: Extension of ALL 
Posts from Top Railing and Extension of ALL Posts from Floor Level. The Extension of 
All Posts from Top Railing edit box is used to specify the value of post above or below the 
top railing. The Extension of ALL Posts from Floor Level is used to specify the height of 
all the posts from the floor.

Fixed Posts at Railing Corners
This check box is used to include the posts present at the railing corners.

Dynamic Posts 
When you select this check box, the Maximum Center to Center Spacing edit box is enabled. 
This edit box is used to modify the distance between two successive dynamic posts. Specify 
the value for distance between the dynamic posts in the edit box; the value will be taken as 
the maximum limit of distance between the two successive posts. When you create a railing 
having length more than this value, a new post is added in the railing.

Balusters 
When you select this check box, the Extension of Balusters from Floor Level and 
Maximum Center to Center Spacing edit boxes are enabled. These check boxes are used to 
modify the values related to baluster. The Extension of Balusters from Floor Level edit box 
is used to specify the distance for bottom point of baluster from the level of corresponding 
tread. The Maximum Center to Center Spacing edit box is used to specify the center to 
center distance between the consecutive balusters.
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Stair Tread Length Override 
When you select this check box, the Number per Tread edit box is enabled. This edit box is 
used to override the value for number of balusters per tread. 

Perpendicular posts 
There are two options available in this drop-down list: Yes and No. When the Yes option is 
selected from this drop-down list, the posts in the railing will be perpendicular to the rails in 
the railing. If you select the No option from this drop-down list, the posts will be perpendicular 
to the tread.   

Railing Extensions
This tool in the Dimension rollout will be available only when railing is added to the stairs and 
there is a need to extend the railing ahead of the stairs. The railings can be extended at two 
levels, either at floor levels or at landings, refer to Figure 3-32.

Figure 3-32  The Railing Extensions dialog box

At Floor Levels Area
When you select the Use Stair Landing Extension check box in the At Floor Levels area, 
the edit boxes given below get activated. You can specify the values for the Top of Entire 
Stair and Bottom of Entire Stair options in the Handrail and Guardrail edit boxes. Select 
the +T check box for adding the tread length to the extension value.

At Landings Area
When you select the Use Stair Landing Extension check box in the At Floor Levels area, 
the edit boxes below it get activated. You can specify the values for top of flight and bottom 
of flight for the Handrail and Guardrail in the respective edit boxes. Select the +T check 
box for adding the tread length to the extension value.
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Note
1. To create a railing attached to stairs, choose the Railing tool from the Stair drop-down; 
the PROPERTIES palette will be displayed. Select the Stairs option from the Attached to 
drop-dwon list in the Location rollout; you will be prompted to select the stairs in the drawing 
area. Select the stairs; the railing will be created along the selected stairs. 

2. The options in Railing Extension dialog box can be edited only when the Allow Each Railing to 
Vary check box is selected in the Extension tab of the Railing Styles option in the Style Manager. 

Stair Tower
This tool is available in the Stair drop-down of the Build panel in the Home tab. This 
tool is used to create a stair tower from one stair. You can create a stair tower by using 

any stair shape except spiral. To create a stair tower, you need to fulfill the conditions given 
next. 

1.	 A stair must already be created in the drawing.
2.	 You must have more than one level in the current project.

CREATING GRIDS, BEAMS, COLUMNS, AND BRACES
To create grids, beams, columns, or braces, the tools are available in the Enhanced Custom Grid 
drop-down in the Build panel of the Home tab in the Ribbon. The tools in this drop-down are 
discussed next.

Enhanced Custom Grid
This tool is available in the Enhanced Custom Grid drop-down. This tool is used 
to create column grids. When you choose this tool, the Column Grid dialog box 

will be displayed, as shown in Figure 3-33. Using the options in this dialog box, you can create 
two types of grids: orthogonal grids and radial grids. The methods to create these grids are 
discussed next.

Creating Orthogonal Grids 
To create orthogonal grids, select the Orthogonal radio button from the top left corner of the 
Grid Layout area; the modified Grid Layout area will be displayed. By default, the Top tab is 
selected in the dialog box. As a result, the grid lines will be created in the Top plane. To create a 
grid line, select the desired distance value from the list available on the left in the Grid Layout 
area; the preview of the grid lines distanced as per the selected value will be displayed in the 
Preview area. Also, the parameters of the grid lines will be displayed in the table on the right 
in the Grid Layout area. Keep on clicking on the desired distance values in the list till you 
get the required number of grid lines. Figure 3-34 shows the Column Grid dialog box after 
selecting values from the list displayed on the left. Similarly, you can add desired number of 
grids to the Bottom, Left, and Right planes. You can change the pattern of labeling by using the 
options available in the X-Labeling and Y-Labeling drop-down lists. Similarly, you can change 
other parameters for grids by using the options available in the dialog box. After setting all the 
parameters, choose the OK button; the grid will be displayed attached to the cursor and you will 
be prompted to specify the insertion point. Specify the insertion point; you will be prompted 
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to specify the rotation angle. Specify the rotation angle; the grid will be created at the specified 
location. Press ENTER to exit the command or you can specify an insertion point to create 
another grid with same specifications. 

Figure 3-33  The Column Grid dialog box

Figure 3-34  The Column Grid dialog box displayed after adding grid lines
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Creating Radial Grids
To create radial grids, select the Radial radio button on the top left corner of the Grid Layout 
area; the modified Grid Layout area will be displayed, refer to Figure 3-35. By default, the Radial 
tab is selected in the dialog box, as a result the grid lines will be created in the radial direction. 
To create a grid line, select the desired angle value from the list available in the left of the dialog 
box; preview of the grid lines, at the selected value, will be displayed in the Preview area. Also, 
the parameters of the grid lines will be displayed in the table on the right in the Grid Layout 
area. You can add the desired number of grid lines by selecting them from the list. Figure 3-36 
shows the Column Grid dialog box after selecting values from the list displayed on the left. 
Similarly, you can add desired number of grids in the form of an arc by selecting the Arcs tab. 
You can change the pattern of labeling by using the options available in the X-Labeling and 
Y-Labeling drop-down lists. Similarly, you can change other settings for grids by using the 
options available in the dialog box. After setting all the parameters, choose the OK button; the 
grid will be displayed attached to the cursor and you will be prompted to specify the insertion 
point. Specify the insertion point; you will be prompted to specify the rotation angle. Specify 
the rotation angle; the grid will be created at the specified location. Press ENTER to exit the 
command or you can specify an insertion point to create another grid with same specifications.

Figure 3-35  The modified Column Grid dialog box after selecting the Radial radio button

Custom Grid Convert
This tool is available in the Enhanced Custom Grid drop-down. It is used to 
convert the network of lines into column grids. When you choose this tool, you 

will be prompted to select a network of lines. The command prompt for creating a grid from 
lines in given next.
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Select linework: Select the network of lines that you want to convert in grid. 
Select linework: 
Enter label extension or [No labels] <1200>: Specify the length of extension line from the grid end point.
Erase selected linework? [Yes/No] <No>: Specify whether you want to delete the network of lines or not.

Figure 3-36  The modified Column Grid dialog box after selecting values from the list

Column Grid
This tool is available in the Enhanced Custom Grid drop-down. It is used to create 
a column grid with predefined parameters. To create a column grid, choose the 

Column Grid tool from the drop-down; you will be prompted to specify the insertion point for 
the grid. Specify the insertion point; you will be prompted to specify the rotation angle for the 
grid. Specify the rotation angle; the grid will be created at the specified insertion point. Again, 
you will be prompted to specify the insertion point for the grid. Press ENTER to exit the 
command. You can edit the parameters of a grid by using the options available in the 
PROPERTIES palette, refer to Figure 3-37. Some important options in this palette are discussed 
next.

Shape
This drop-down list is available in the General rollout of the PROPERTIES palette. The 
options in this drop-down list are used to change the shape of the grid to be created. There are 
two options available in this drop-down list: Rectangular and Radial. When the Rectangular 
option is selected, the grid to be created will be rectangular in shape. There will be horizontal 
and vertical grid lines in the grid. When you select the Radial option, the grids will be in the 
form of arcs and in the radial direction. 
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Specify on screen
This drop-down list is available in the Dimensions

Figure 3-37  The PROPERTIES palette 
displayed on choosing the Column Grid tool

 
rollout of the PROPERTIES palette. The options in 
this drop-down list are used to specify the method for 
dimensioning the column grids. There are two options 
available in this drop-down list: Yes and No. When you 
choose the Yes option, you will be prompted to specify 
the corner points of the column grids in the screen. If 
the No option is chosen, then you need to specify the 
dimensions in the edit boxes available in the 
PROPERTIES palette.        

X - Width
This edit box is available for both rectangular 
shaped and radial shaped grids. This edit box in the 
Dimensions rollout of the PROPERTIES palette gets 
activated only when the No option is selected in the 
Specify on screen drop-down list. This edit box is used 
to specify the value for the width of the grid.  

Y - Depth
This edit box is available for rectangular shaped grids 
only. This edit box in the Dimensions rollout of the 
PROPERTIES palette gets activated only when the No option is selected in the Specify on 
screen drop-down list. This edit box is used to specify the value for the depth of the grid. 

A - Angle
This edit box is available for the radial shaped grids only. This edit box in the Dimensions 
rollout of the PROPERTIES palette gets activated only when the No option is selected in the 
Specify on screen drop-down list. This edit box is used to specify the value for angle of the grid. 

Layout type
This drop-down list is available in both the X Axis rollout as well as the Y Axis rollout. There 
are two options available in this drop-down list: Repeat and Space evenly. When the Repeat 
option is selected, the distance between the two grids is fixed and depending on the total size 
specified, the number of grid lines are inserted. If the Space evenly option is selected in the 
Layout type drop-down list, the total number of grid lines will be fixed and depending on the 
total size of grid boundary, the distance between the two grid lines will be adjusted. 

Bay size
This edit box is available in both the X Axis and the Y Axis rollouts. This edit box is available 
only when the Repeat option is selected in the Layout type drop-down list. You can specify the 
distance between two grid lines perpendicular to the X and Y axes by using the edit box in the 
respective rollout.  
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Number of bays
This edit box is available in both the X Axis rollout as well as the Y Axis rollout. This edit box is 
available only when the Space evenly option is selected in the Layout type drop-down list. You 
can specify the number of grid lines along X axis by using the edit box in the respective rollout. 

Style
This drop-down list in the Column rollout of the PROPERTIES palette for the column grid will 
be available only after the custom convert column is applied to the drawing. It is used to change 
the type of column to be used for building the grid. The options available in this drop-down list 
are NONE, 8mm Drop Rod Support, CH421 (40X20X1.5) Roll Formed Channel Profile, and 
Standard.

Column
This tool is available in the Enhanced

Figure 3-38  The PROPERTIES palette 
displayed on choosing the Column tool

 
Custom Grid drop-down. This tool is used 

to create a column with predefined parameters. To 
create a column, choose the Column tool from the 
drop-down; you will be prompted to specify the 
position of  the column in the drawing area. Select a 
point on the grid or specify a point in the drawing 
area; you will be prompted to specify the roll 
(rotation) of the column. Specify the roll by clicking 
in the drawing area or by specifying value in the 
command prompt; the column will be created at the 
specified point. You can change the parameters of 
the column by using the options available in the 
PROPERTIES palette, refer to Figure 3-38. Some 
of the important options in the PROPERTIES 
palette are discussed next. 

On object
This drop-down list is available in the General 
rollout. There are two options available in this 
drop-down list: Yes and No. When you select the 
Yes option, the column will be attached to the base 
object. If you move the base, the column will also 
move accordingly. When you choose the No option, 
the column will be placed as a separate object having 
no link with other objects.

Start offset
This edit box is available in the Dimensions rollout. In this edit box, you can specify the offset 
value for the start point of the column from the insertion point. 

End offset
This edit box is available in the Dimensions rollout. In this edit box, you can specify the offset 
value for the end point of the column from the insertion point.
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Logical Length
This edit box is available in the Dimensions rollout. In this edit box, you can specify the value 
for the length of the column.

Specify roll on screen
This drop-down list is available in the Dimensions rollout. There are two options available 
in this drop-down list: Yes and No. When you select the Yes option, you will be prompted to 
specify the value for the rotation while placing the column. When you select the No option, you 
need to specify the value for the rotation of the column in the Roll edit box available in the 
PROPERTIES palette.

Roll
This edit box is available in the Dimensions rollout only when the No option is selected in the 
Specify roll on screen drop-down list. In this edit box, you can specify the value for rotation 
of the column being created. 

Justify
This drop-down list is available in the Dimensions rollout. There are ten options available in 
this drop-down list to change the justification of the column. 

Justify cross-section
This drop-down list is available in the Dimensions rollout. There are two options available in this 
drop-down list: Maximum and At each node. When you select the Maximum option from the 
drop-down list, the justification method is applied only to the columns having maximum cross 
section. When you choose the At each node option from the drop-down list, the justification 
method is applied to every column.  

Justify components
This drop-down list is available in the Dimensions rollout. There are two options available in 
this drop-down list: Highest priority only and All. When you select the Highest priority only 
option from the drop-down list, the justification methods will be applied only to the columns 
having highest priority. When the All option is selected from the drop-down list, then the 
justification method is applied to all the columns.

Custom Column
This tool is available in the Enhanced Custom Grid drop-down. This tool is used 
to create a user defined column. To create a custom column, choose the Custom 
Column tool; you will be prompted to select a closed polyline, a closed spline, a 

circle, or an ellipse. Select a closed entity; you will be prompted to specify the insertion point 
or centroid. Select a point to specify as insertion point or centroid; the Convert to Column 
dialog box will be displayed, as shown in Figure 3-39. Specify the name of the column in the 
New Name edit box and choose the OK button from the dialog box; the custom column will be 
created at the specified location.  



3-42			                	       AutoCAD MEP for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om Figure 3-39  The Convert to Column dialog box

You can change the properties of a custom created column by using the PROPERTIES palette, 
refer to Figure 3-40. Some of the important options available in the PROPERTIES palette after 
selecting a custom column are discussed next.

Figure 3-40  The PROPERTIES palette

Bound spaces
This drop-down list is available in the General rollout. There are three options available 
in this drop-down list: Yes, No, and By style (NO). When the Yes option is selected in the 
drop-down list, the created object will act as a space boundary. When the No option is selected in 
the drop-down list, the created object will not act as a space boundary. When the By style (NO) 
option is selected in the drop-down list, the boundary conditions of the object are specified by 
the style of the object.



Working with Architecture Workspace		                                   3-43                                                               

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Trim automatically
This drop-down list is available in the General rollout. There are three options available in this 
drop-down list: Yes, No, and By style (NO). When the Yes option is selected in the drop-down 
list, the created object will get automatically trimmed to join with the connecting object. When 
the No option is selected in the drop-down list, the created object will not get automatically 
trimmed to join with the connecting object. When the By style (NO) option is selected in the 
drop-down list, the trimming conditions of the object are specified by the style of the object.

Member type
This drop-down list is available in the General rollout. There are three options available in 
this drop-down list: Beam, Column, and Brace. You can choose the Beam option from this 
drop-down list to create a custom beam. By default, the Column option is selected in the 
drop-down list. This option is used to create a column. You can create a brace by choosing the 
Brace option from the drop-down list.

The other options in the PROPERTIES palette have already been discussed.

Beam
This tool is available in the Enhanced Custom Grid drop-down. This tool is used to 
create a beam. To create a beam, choose the Beam tool; you will be prompted to specify 

the start point of the beam. Specify the start point of the beam; you will be prompted to specify 
the end point of the beam. Specify the end point of the beam; the beam will be created with the 
specified parameters. You can specify the parameters of the beam in the PROPERTIES palette. 
The options available in the PROPERTIES palette for beam are similar to the options available 
for custom column. The options that are available only for a beam are discussed next.

Array
This drop-down list is available in the Layout rollout. There are two options available in this 
drop-down list: Yes and No. The No option is selected by default in the drop-down list. When 
you select the Yes option, you can create multiple instances of the beam. On selecting the Yes 
option, the Layout method and Number of bays options become available in the Layout rollout. 
These options are used to specify the parameter for creating multiple instances of the beam.

Layout method
This drop-down list is available in the Layout rollout. There are two options available in this 
drop-down list: Space evenly and Repeat. When you select the Space evenly option, the instances 
are spaced equally over the total distance. When you select the Repeat option, the instances are 
spaced according to the specified distance value specified.  

Number of bays
This edit box is available in the Layout rollout. In this edit box, you can specify the value for 
number of instances of the beam.

Brace
This tool is available in the Enhanced Custom Grid drop-down. This tool is used to 
create a brace. To create a brace, choose the Brace tool; you will be prompted to specify 
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the start point of the brace. Specify the start point of the brace; you will be prompted to specify 
the end point of the brace. Specify the end point of the brace; the brace will be created with the 
specified parameters. You can specify the parameters of the brace in the PROPERTIES palette. 
The options available in the PROPERTIES palette for brace are similar to the options available 
for the custom column. The options that are available only for a brace are discussed next.

Specify rise on screen
This drop-down list is available in the Rise rollout. There are two options available in this 
drop-down list: Yes and No. The Yes option is selected by default in the drop-down list. So 
you need to specify the value of rise on the screen while placing the braces. When you choose 
the No option, you can set the parameters related to rise by using the options available in the 
PROPERTIES palette. 

Method
This drop-down list is available in the Rise rollout. There are two options available in this 
drop-down list: Angle and Distance. On choosing the Angle option, you can set the value of 
rise by specifying angle value in the Angle from first member edit box. 

Distance along first member
This edit box is available in the Rise rollout. You can specify the value for distance of start point 
of the brace along the first member. 

Angle from the first member
This edit box is available only when the Angle option is selected in the Method drop-down list. 
You can specify the value for rotation of the brace with respect to the first member. 

CREATING PRIMITIVES
You can create basic objects like box, cylinder, torus and so on by using the tools available in 
AutoCAD MEP. These basic objects are called primitives. The tools to create primitives are 
available in the Box drop-down of the Build panel. The tools available in this drop-down 
are discussed next. The options for creating different primitive shapes also displayed in the 
command prompt.

Note
For better visualization, you may need to rotate the ViewCube while creating primitives shapes.

Box
The Box tool is used to create a box with the specified dimensions. To create a box, choose 
the Box tool from the Box drop-down in the Build panel; you will be prompted to specify 

the first corner of the box. Specify the first corner of the box; you will be prompted to specify 
the second corner of the box. Specify the second corner of the box; you will be prompted to 
specify the height of the box. Specify the height of the box; you will be prompted to specify the 
rotation angle of the box. Specify the rotation value; the box will be created.

Pyramid
The Pyramid tool is used to create a pyramid with the specified dimensions. To create 
a pyramid, choose the Pyramid tool from the Box drop-down in the Build panel; you 
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will be prompted to specify the first corner point of the pyramid. Specify the first corner point 
of the pyramid; you will be prompted to specify the second corner point. Specify the second 
corner point; you will be prompted to specify the height of the apex. Specify the height of the 
apex; you will be prompted to specify the rotation angle of the pyramid. Specify the value for 
rotation; a pyramid with specified settings will be created. 

Cylinder
The Cylinder tool is used to create a cylinder of some specified dimensions. To create 
a cylinder, choose the Cylinder tool from the Box drop-down in the Build panel; you 

will be prompted to specify the insertion point of the cylinder. Specify the point in the drawing 
area; you will be prompted to specify the radius. Enter the radius value; you will be prompted 
to specify the height of the cylinder. Specify the height of the cylinder; you will be prompted to 
specify the rotation angle. Specify the value for rotation; a cylinder of specified dimensions will 
be created.

Right Triangle
The Right Triangle tool is used to create a right triangle mass of some specified 
dimensions. To create a right triangle, choose the Right Triangle tool from the Box 

drop-down in the Build panel; you will be prompted to specify the first corner point of the right 
triangle. Specify the point in the drawing area; you will be prompted to specify the second corner 
point of the right triangle. Specify the second corner point; you will be prompted to specify the 
height of the apex. Specify the height of the apex; you will be prompted to specify the rotation 
angle of the right triangle. Specify the value for rotation; a right triangle of specified dimensions 
will be created.

Isosceles Triangle
The Isosceles Triangle tool is used to create an isosceles triangle mass of some 
specified dimensions. The procedure to create an isosceles triangle is similar to the 
procedure of creating a right triangle mass.

Cone
The Cone tool is used to create a cone of some specified dimensions. To create a cone, 
choose the Cone tool from the Box drop-down in the Build panel; you will be prompted 

to specify the insertion point of the cone. Specify the point in the drawing area; you will be 
prompted to specify the radius. Enter the radius value; you will be prompted to specify height 
of the cone. Specify the height of the cone; you will be prompted to specify the rotation angle. 
Specify the value of rotation; a cone of specified dimensions will be created.

Dome
The Dome tool is used to create a dome of some specified dimensions. To create a dome, 
choose the Dome tool from the Box drop-down in the Build panel; you will be prompted 

to specify the insertion point of the dome. Specify the point in the drawing area; you will be 
prompted to specify the radius. Enter the radius value; you will be prompted to specify the 
rotation angle. Specify the value of rotation; a dome of specified dimensions will be created.
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Sphere
The Sphere tool is used to create a dome of some specified dimensions. To create a 
sphere, choose the Sphere tool from the Box drop-down in the Build panel; you will 

be prompted to specify the insertion point of the sphere. Specify the point in the drawing area; 
you will be prompted to specify the radius. Enter the radius value; you will be prompted to 
specify the rotation angle. Specify the value of rotation; a sphere with of dimensions will be 
created.

Arch
The Arch tool is used to create an arch with the specified dimensions. To create an 
arch, choose the Arch tool from the Box drop-down in the Build panel; you will be 

prompted to specify the first corner point of the base. Specify the point in the drawing area; 
you will be prompted to specify the second corner point of the base. Specify the second corner 
point; you will be prompted to specify the height of the arch. Specify the height of the arch; you 
will be prompted to specify the rotation angle of the arch. Enter the value of rotation angle; an 
arch will be created with the specified parameters. 

Gable
The Gable tool is used to create a gable of some specified dimensions. To create a 
gable, choose the Gable tool from the Box drop-down in the Build panel; you will be 

prompted to specify the first corner point of the base. Specify the point in the drawing area; 
you will be prompted to specify the second corner point of the base. Specify the second corner 
point; you will be prompted to specify the height of the gable. Specify the height of the gable; 
you will be specify the rotation angle of the arch. Enter the value of the rotation angle; a gable 
of specified dimensions will be created.

Barrel Vault
The Barrel Vault tool is used to create a barrel vault of some specified dimensions. 
To create a barrel vault, choose the Barrel Vault tool from the Box drop-down in the 

Build panel; you will be prompted to specify the first corner point of the base. Specify the point 
in the drawing area; you will be prompted to specify the second corner point of the base. Specify 
the second corner point; you will be prompted to specify the rotation angle of the barrel vault. 
Enter the value of the rotation angle; a barrel vault of the specified dimensions will be created.

Drape
The Drape tool is used to create a drape of some specified parameters. A drape is 
used to show contour of the site. You can create a drape with the help of polylines or 

polygons. To create a drape, choose the Drape tool from the Box drop-down in the Build panel; 
you will be prompted to select objects representing the contour. Select polylines or other objects 
representing the contour and then press ENTER; you will prompted to erase or retain the 
selected contours. Enter Y or N at the command prompt; you will be prompted to generate a 
regular mesh. Enter Y or N at the command prompt. On specifying N at the command prompt, 
you will be prompted whether to generate a rectangular mesh. On entering Y at the command 
prompt; you will be prompted to specify the first corner of the rectangle to create a mesh. Specify 
a point in the drawing area; you will be prompted to specify the opposite corner of the rectangular 
mesh. Specify the opposite corner of the mesh; you will be prompted to specify the number of 
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subdivisions along the X direction. Enter the desired number of subdivisions at the command 
prompt; you will be prompted to specify the number of subdivisions along the Y direction. Enter 
the number of subdivisions at the command prompt; you will be prompted to specify the thickness 
value of the base. Enter the value of thickness at the command prompt; the drape with the 
selected contours will be created.

Doric
The doric pillar is used for creating heritage type vertical structures. The Doric tool will be 
available only after Box is selected from the Primitives drop-down in the Build panel of the 
Home tab; the Shape option pops up in the command prompt. Select Shape in the command 
prompt; various options for different shapes get displayed in the command bar. Select the DORic 
option. Specify the center point of the doric shape in the drawing area; you will be prompted to 
specify the radius. Enter the radius value in the command bar; you will be prompted to specify 
the height of the doric shaped pillar. Specify the height for the pillar; you will be prompted to 
specify the rotation angle. Specify the value for the rotation angle; a doric pillar of specified 
dimensions will be created.

TUTORIALS

Tutorial 1  								                
In this tutorial, you will create a model of a building, as shown in Figure 3-41. The plan of the 
building is given in Figure 3-42. 					          (Expected time: 30 min)

Figure 3-41   Model of a building



3-48			                	       AutoCAD MEP for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 3-42   Plan view of a building

	 Examine the model to determine the number of features in it. The model consists of three 
features, refer to Figure 3-41.

	 The following steps are required to complete this tutorial:

a.	 Create a project file with the name Office.
b.	 Create a new construct plan with the name C03_tut01.
c.	 Create walls by using the reference of line diagram, refer to Figures 3-42 and 3-43.
d.	 Create doors according to the plan, refer to Figures 3-42 and 3-44.
e.	 Create windows according to the plan, refer to Figure 3-42.

Starting a New Project File
1.	 Start AutoCAD MEP by using AutoCAD MEP 2016 - English (Global) icon from the desktop. 

Next, choose New > Project from the Application Menu; the Project Browser is displayed.

2.	 Choose the New Project button available at the bottom of the Project Browser; the Add 
Project dialog box is displayed. 

3.	 Enter the project name as Office in the Project Name field. Also, enter the Project Number 
as 0001 and specify the description about the project as desired in their respective fields. 
Make sure that the Create from template project check box is selected.

4.	 Choose the Browse button and select the file Commercial Template Project (Metric).apj from the 
C:\ProgramData\Autodesk\MEP 2016\enu\Template\Commercial Template Project (Metric) directory 
and then choose the Open button; the path of the selected file is added to the edit box 
displayed below the Create from template project check box.

5.	 Choose the OK button; the newly created project file name is displayed in the left pane of 
the Project Browser.
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6.	 Choose the Close button from the Project Browser; the PROJECT NAVIGATOR palette 
is displayed in the drawing area and the new project is activated. By default, the Constructs 
tab is active in the PROJECT NAVIGATOR.

		   
Adding a New Construct
1.	 Choose the Construct tab in the PROJECT NAVIGATOR.

2.	 Choose the Add Construct button available at the bottom of the PROJECT NAVIGATOR; 
the Add Construct dialog box is displayed.

3.	 Click in the Name field and specify the name of construct as C03_tut01. Make sure the  Open 
in drawing editor check box is selected and choose the OK button; the C03_tut01 drawing 
file is opened.

Creating Walls
	 Now, you will create walls. 

1.	 Choose the Architecture option from the Workspace Switching flyout, if not already selected. 

2.	 Choose the Wall tool from the Wall drop-down available in the Build panel of the Home tab; 
you are prompted to specify the start point of the wall. Also, the corresponding PROPERTIES 
palette is displayed.

2.	 Specify the value for width, base height, and justify as 254, 4000, and Center, respectively, 
in their respective fields in the Dimensions rollout of the PROPERTIES palette.

3.	 Click to specify the start point of the wall and then create the walls, as shown in 
Figure 3-43. For dimensions, refer to Figure 3-42. 

Figure 3-43   Walls created 

Creating Doors
	 Now, you will create doors. For dimensions, refer to Figure 3-42. 

1.	 Choose the Door tool from the Door drop-down available in the Build panel of the Home 
tab; you are prompted to select a wall or a grid assembly. Also, the PROPERTIES palette 
is displayed.
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2.	 Specify the value for width and height as 1500 and 3500, respectively, in their respective 
fields in the Dimensions rollout of the PROPERTIES palette. Also, select the Offset/Center 
option from the Position along wall field in the Location rollout of the PROPERTIES 
palette. 

Note
The Offset/Center option helps you to justify the position of the doors at the center of the wall.

3.	 Click at the required locations to place the door D1, refer to Figure 3-42.

4.	 Now, specify width as 2000 in the Width field available in the Dimensions rollout of the 
PROPERTIES palette and create the main gate D2. For positioning the gates, refer to 
Figure 3-42.

	 After creating the doors, the drawing is displayed, as shown in Figure 3-44.

Figure 3-44   The drawing after creating gates 

Creating Windows
	 Now, you will create windows with the specifications given in Figure 3-42. 

1.	 Choose the Window tool from the Window drop-down available in the Build panel of the 
Home tab; you are prompted to select a wall or a grid assembly. Also, the PROPERTIES 
palette with corresponding options is displayed.

2.	 Specify the value for width and height for the window as 2000 and 1510 respectively, in 
their corresponding fields in the Dimensions rollout of the PROPERTIES palette. Also, 
select the Offset/Center option from the Position along wall field in the Location rollout 
of the PROPERTIES palette. 

3.	 Click at the required locations to create the windows W1, refer to Figure 3-42.
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	 The final model in the SW Isometric view and the Conceptual display style is shown in 
Figure 3-45.

Figure 3-45   Model of a building

Saving the Drawing File
1.	 Choose Save from the Application Menu to save the drawing file with the name c03_tut1.

Tutorial 2  								                
In this tutorial, you will create a model of a building, as shown in Figure 3-46. The plan of the building 
is given in Figure 3-47. 						               (Expected time: 30 min)

Figure 3-46   Model of a building
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Figure 3-47  The plan of the building

	 The following steps are required to complete this tutorial:

a.	 Create a new project file.
b.	 Create a new construct with the name C03_tut02.
c.	 Create walls by using the reference of the line diagram, refer to Figure 3-48.
d.	 Create doors according the plan, refer to Figure 3-47.
e.	 Create the roof according to the plan, refer to Figure 3-49.
f.	 Create the stairs, refer to Figure 3-50.
g.	 Create a cut in the slab for railing, refer to Figure 3-52.
h.	 Create railing on the stairs.

	 After starting the AutoCAD MEP session, the first task is to create a project. 

Starting a New Project File
1.	 Start AutoCAD MEP by using AutoCAD MEP 2016 - English (Global) icon from the desktop, 

if not started and then choose New > Project from the Application Menu; the Project 
Browser is displayed.

2.	 Choose the New Project button available at the bottom of the Project Browser; the Add 
Project dialog box is displayed. 

3.	 Enter the project name as Machining Plant in the Project Name field. Also, enter the 
project number and description in their respective fields. Select the Commercial Template 
Project (Metric).apj as template for the project using the Browse button. 

4.	 Choose the OK button; the new created project file name is displayed on the left pane of 
the Project Browser.

5.	 Choose the Close button from the Project Browser; the PROJECT NAVIGATOR palette 
is displayed in the drawing area and the new project is activated. 
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Adding a New Construct
1.	 Choose the Constructs tab from the PROJECT NAVIGATOR. Choose the Add Construct 

button available at the bottom of the PROJECT NAVIGATOR; the Add Construct dialog 
box is displayed.

2.	 Click in the Name field and specify the name of the construct as C03_tut02.  Make sure that 
Open in drawing editor check box is selected and choose the OK button; the C03_tut02 
drawing file is opened.

Creating Walls
	 Now, you need to create walls. Make sure that the Architecture workspace is active. 

1.	 Choose the Wall tool from the Wall drop-down available in the Build panel of the Home 
tab; you are prompted to specify the start point of the wall. Also, the PROPERTIES palette 
is displayed.

2.	 Specify width, base height, and justify as 254, 4500, and Center, respectively in their 
respective fields in the Dimensions rollout of the PROPERTIES palette if not specified.

3.	 Click to specify the start point of the wall and then create the walls, as shown in Figure 3-48. 
For dimensions, refer to Figure 3-47.

Figure 3-48   Walls created using reference of line diagram

Creating Doors
	 Now, you need to create doors. For dimensions, refer to Figure 3-47. Make sure that the 

Architecture workspace is active. 

1.	 Choose the Door tool from the Door drop-down available in the Build panel of the Home 
tab; you are prompted to select a wall or a grid assembly.

	 Note that the PROPERTIES palette with the corresponding options is displayed.

2.	 Specify width and height as 1500 and 3500 respectively, in their respective fields in the 
Dimensions rollout of the PROPERTIES palette.
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3.	 Also, select the Offset/Center option from the Position along wall field in the Location 
rollout and make sure that the Standard option is selected in the Style drop-down list of 
the PROPERTIES palette.

4.	 Click at the required locations to create the doors D1, refer to Figure 3-47.

	 Now, you need to create  the hinged double doors. As these doors are not available by default, 
so you need to select the Hinged-Double door option from the PROPERTIES palette.

5.	 Select the Door tool from the Door drop-down available in the Build panel of the Home 
tab; you are prompted to select a wall or a grid assembly. Also, the PROPERTIES palette 
with the corresponding options is displayed.

6.	 Click on the Style preview area in the PROPERTIES palette; the STYLES BROWSER 
palette is displayed. Choose the Hinged-Double door option from the gallery of  STYLE 
BROWSER and double-click on it to select the door style. 

7.	 Specify width and height as 4000 and 3500 in their respective fields in the Dimensions 
rollout of the PROPERTIES palette. Select the Unconstrained option from the Position 
along wall field in the Location rollout of the PROPERTIES palette. 

Note
The Unconstrained option is chosen in the Position along wall field of the Location rollout, 
so you can place the door D2 without any dimension reference.

8.	 Click at the required location to position the doors D2, as shown in the Figure 3-47.	

	 After creating the doors, the drawing is displayed as shown in Figure 3-49.

Figure 3-49  The drawing after creating all the doors

Creating Slab
	 Now, you need to create the slab with the specifications shown in Figure 3-50. 

1.	 Choose the Slab tool from the Roof Slab drop-down available in the Build panel of the 
Home tab; you are prompted to specify the start point of the slab.
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2.	 Select one of the corner points of the building displayed in Figure 3-50; you are prompted 
to specify the next point for the slab.

3.	 Select rest of the corner points as shown in Figure 3-50.

Figure 3-50  Corner points for the slab

Creating Stairs
	 Now, you will create stairs attached to the slab. 

1.	 Choose the Stair tool from the Stair drop-down available in the Build panel of the Home 
tab; you are prompted to specify the flight start point. Also, the PROPERTIES palette is 
displayed with the options relevant to stairs.

2.	 Specify width, height, justification, and termination as 1000, 4500, Right, and Landing  in 
their respective fields in the PROPERTIES palette. Also, choose Straight from the Shape 
drop-down list in the General rollout.

3.	 Select a starting point for stairs and align it with the adjacent wall, refer to Figure 3-51.  

Figure 3-51   Starting point of the stairs

	 Now, you will create a cut on the slab to allow a passage through the stairs to the top of the 
roof.  
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Creating Cut in the Slab
1.	 Choose the Rectangle tool from the Rectangle drop-down available in the Draw panel of 

the Home tab; you are prompted to specify the first corner point. Specify the corner points 
for the rectangle, as shown in Figure 3-52.

Figure 3-52   Rectangle to be created for cut in the slab

2.	 Select the slab and choose the Trim tool from the Modify panel in the Slab contextual tab; 
you are prompted to select a trimming object like a polygon or a solid object.

3.	 Select the rectangle created for the cut and press ENTER; you are prompted to specify the 
side to be deleted.

4.	 Click inside the rectangle, the area covered by the rectangle is trimmed. Press ESC to exit 
the tool.

	 Now you need to hide the rectangle geometry created for trimming.

5. 	 Right-click on the rectangle; a shortcut menu is displayed. Move the cursor on the Isloate 
Objects option in the shortcut menu; a flyout is  displayed. Choose the Hide Objects option 
to hide the rectangle.

	 Isometric view of the drawing after creating the cut is shown in Figure 3-53.

Figure 3-53   Drawing after creating the cut in the slab
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Creating Railing on the Stairs
1.	 Choose the Railing tool from the Stair drop-down available in the Build panel of the Home 

tab; you are prompted to specify the start point for the railing. 

2.	 Choose Attach and then the Stair option from the command prompt; you are prompted to 
select a stair.

3.	 Select the stairs created earlier; a railing with the standard settings is created in the drawing 
area.

4.	 Deselect all the entities, select the railing, and invoke the PROPERTIES palette.

5.	 Enter 900 in the Side offset field in the Location rollout of the PROPERTIES palette.

	 After creating all the components, the final drawing (in conceptual view) is displayed, as 
shown in Figure 3-54.

Figure 3-54   The final drawing

Saving the Drawing File
1.	 Choose Save from the Application Menu to save the drawing file with the name c03_tut2.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 A __________ is an opening in a wall or door to facilitate the passage of air and light.

2.	 The __________ tool is used to create a segment of roof which is not connected with other 
entities.
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3.	 A __________ window can be created on a cornered wall.

4.	 You cannot create a curved wall using the Wall tool. (T/F)

5.	 A curtain wall is a non-structural wall. (T/F)

6.	 Using the Stair tool, you can create only straight stairs. (T/F)

 Review Questions 
Answer the following questions:

1.	 On selecting a slab, the __________ contextual tab gets activated in the Ribbon.

2.	 The __________ tool is used to convert the network of lines into column grids. 

3.	 Using the options in the Style Manager, you can create custom doors. (T/F) 

4.	 Spiral stairs can be created only in clockwise direction. (T/F) 

5.	 The Railing tool can be used to attach railing to a stair. (T/F)

EXERCISE
Exercise 1

Create the model of building, as shown in Figure 3-55. The plan view of the building is shown 
in Figure 3-56.	 						             (Expected time: 45 min)

Figure 3-55  Model for Exercise 1
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Answers to Self-Evaluation Test  
1. window, 2. Roof Slab, 3. cornered, 4. F, 5. T, 6. F


